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Warm up Questions:

 Question:  What are the chunks of data that 

are sent over the internet called?

 Question:  What protocal is in charge of 

dividing the data that goes over the internet 

into chunks?

 Question:  Give an example of a valid IP 

address.

WEB SITE DESIGN & 

SETUP

Computer Science 1033 – Week 7

“What separates design from art is that design is meant 

to be… functional.” ― Cameron Moll

https://www.youtube.com/watch?v=j2G1IUpRiPY

Tip 1:0:15 Tip 2 2:45: Tip 3: 4:15  Tip 4:  5:30  Tip 5: 7:20
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Overview of Today’s Topics

 Announcements

 Overview of Assignment 2

 Good and bad websites

 Websites and Webpage organization

 index.html  importance of

 HTML

 Break

 BlueGriffon review
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Textbook Readings for this Week

 Websites

◦ Websites

◦ Website Development

◦ Design Principles
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REQUIRED Homework
 You MUST watch these 4 videos about Copyright 

Rules and Creative Commons on your OWN time:

◦ Creative Common Vimeo:

 https://creativecommons.org/about/videos/creative-commons-kiwi/

 Go to linkedin.com/learning and log in with your 

Western credentials 

 In linkedin.com/learning search for this course: Copyright for 

Creatives: Protecting Your Work. 

Then watch the following videos:

 Defining copyright

 What can you copyright

 Copyright myths

 Copyright reality
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Announcements

 Exam Schedule  our exam is scheduled for 

2PM on Thursday, April 23rd

 Poster Assignment are marked

 You can ask for a remark but I remark the 

whole assignment and your mark could go 

lower.

 Assignment 2 is due Friday, March 13th

◦ I will do a demo for assignment 2 next week. 

◦ PLEASE try to hand it in on Wed or Thur to make 

your life easier!

https://www.youtube.com/watch?v=j2G1IUpRiPY
https://creativecommons.org/about/videos/creative-commons-kiwi/
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Assignment 2

 Two nice examples from previous years to 

get you thinking!

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/st

udent25/major/references.html

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/st

udent15/
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Announcements 

 Web Assignment 

◦ IT will take you longer than you think, give yourself 
LOTS of time to finish it and to hand it in (Hand it in 
on before Wednesday, the labs will be VERY busy on 
Thursday and Friday).

◦ Hints:

 Remember your titles 

 Think about layout, consistency, ease of use!

 Follow the specs

 Use a table for a clean layout (put the banner in the top 
row and content in the bottom row)

 Common Mistakes 
http://www.csd.uwo.ca/~lreid/cs1033/assignment3/Samples
OfCommonMistakes/
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Announcements 
 Web Assignment Hints

 THINGS THAT CAN GO HORRIBLY WRONG 
 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student1/

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student2

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student3/assign3/howtohelp.html
(need to scroll for buttons, bullets, banner)

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student9/major/ (consistency)

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student19/

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student20 (edges)

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student14 (scrolling and banner 
on next page)

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student22

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student18/Contact%20Us.html
(file names and button movement)

 THINGS THAT CAN GO RIGHT 
 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student8/assign3/registration.html

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student22/assign3/

 http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student15/index.html
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 Paragraphs  Centering  DON’T

 Hyphens on lists

 Emails links

 Back to top, anchors

 Think about link colours

 Link lengths 

◦ http://www.csd.uwo.ca/images/CSD_long_photo_16.jpg

vs.

◦ Middlesex

 Common Mistake: renaming 

files/folder…this will TOTALLY SCREW up 

your website if you do not do it correctly!
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Things to remember, especially for Web 

Assignment and Major Assignment

 Keep the menu in the same place on every page. 

(either the top or the left, it is up to you)

 Should not have to scroll horizontally

 Should not have to scroll vertically to see 

navigation buttons

 Keep the colours consistent on every page

 Keep the layout fairly consistent on every page

 Should always have a way to get home

 Long pages should have a “Back to Top” button
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Hints for Web Assignment

 Remember:

◦ Titles

◦ Headers

◦ File names, spaces, lowercase

◦ Images

 Alt, Title

 Size within page

 On each page

◦ Banner 

◦ No Scrolling horizontal/vertically to 

see buttons

◦ Consistency

◦ Buttons  look, ease of use

◦ Back to top

◦ References page layout

◦ Text colours, contrast

◦ Broken links

 Check from a different computer!

◦ Underlining

◦ Colours

 Link Colours

◦ Paragraphs

◦ Padding

◦ Followed the instructions 

(make the anchor links, etc..)

http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student25/major/references.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student15/
http://www.csd.uwo.ca/~lreid/cs1033/assignment3/SamplesOfCommonMistakes/
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student1/
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student2
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student3/assign3/howtohelp.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student9/major/
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student19/
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student20
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student14
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student22
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student18/Contact%20Us.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student8/assign3/registration.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student22/assign3/
http://cs1033.gaul.csd.uwo.ca/~lreid2/other/student15/index.html
http://www.csd.uwo.ca/images/CSD_long_photo_16.jpg
http://www.csd.uwo.ca/images/CSD_long_photo_16.jpg
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How to do Web Assignment
 Colours  look at: http://kuler.adobe.com/

 https://www.design-seeds.com/

 Marks for:

 Nice Banner

 Good Colour Scheme

 Alt/title tag on banner/images

 No scrolling horizontally EVER at 1000 pixels

 Consistency in the layout of the pages and the 

buttons/NICE LAYOUT ON EVERY PAGE

 NO Underlining

 Roll over buttons get 1 or 2 marks more

 PROPERTY TITLES! Website – Web Page

◦ Antonio’s Restaurant – Home 

◦ Antonio’s Restaurant – References 

 Must use table to lay things out

 Headings on pages

 Use an image for each page/good size

 Layout paragraphs well (don’t squish on edge)

 Bold/highlight headings
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What do you think of these sites?
 http://www.brescia.uwo.ca

 http://www.margarethe-vanderpas.com/

 http://www.mariasemple.com/

 https://wrightwoodfurniture.com/

 www.distancetomars.com

 https://etch.co/ (hmmm???)

 https://www.newyorker.com
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How about these sites?

 https://history.aip.org/climate/index.htm

 http://www.lingscars.com

 http://www.jamilin.com/

 http://www.gatesnfences.com/
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Good Website Design Tips

 http://www.youtube.com/watch?v=JQwTqt8gkjM

 Have something valuable to offer  provide 
something useful or interesting

 Don’t distract with blinking, animated GIFs, 
autoloading sound, too much scrolling

 No popups!

 Don’t use images on the background unless you 
know what your doing

 Put a lot of thought into the organization of your 
page

 Minimize clicking (no more than 3 clicks to get 
to a page)
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More Tips

 Have a way to get to the home page on every 
page

 Include a menu on every page (in the same 
location on every page)

 Compress your images

 Don’t let multimedia files bog down your 
website

 No line of text should be more than 600 pixels 
wide

 Don’t make your page too wide (around 900 to 
1000 pixels), user should NEVER have to do 
horizontal scrolling.  Vertical scrolling should be 
kept to a minimum

http://kuler.adobe.com/
https://www.design-seeds.com/
http://www.brescia.uwo.ca/
http://www.margarethe-vanderpas.com/
http://www.mariasemple.com/
https://wrightwoodfurniture.com/
http://www.distancetomars.com/
https://etch.co/
https://www.newyorker.com/
https://history.aip.org/climate/index.htm
http://www.lingscars.com/
http://www.jamilin.com/
http://www.gatesnfences.com/
http://www.youtube.com/watch?v=JQwTqt8gkjM
http://christmaschebacca.ytmnd.com/
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More Tips

 Use contrasting colors or simple 

backgrounds to make text easy to read

 Make text large enough to read

 Use ALL CAPITAL LETTERS sparingly,

 Never use more than one exclamation point

 Spell Check

 Never underline words that are not links

 Put contact info or a link to it on every page
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More Tips
 Test your links

 Remove dead links

 Avoid confusing navigation and having menus 

in different spots on different pages

 Avoid ugly design: no color continuity

 Don’t have text that hard to read

 Include a “Last Modified” date

◦ Keep up to date, update your “What’s New” 

section frequently

 Don’t steal content (I stole this content is 

from: http://websitehelpers.com/design  )
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More Tips

 Think about how the user will navigate through 

your website and remember the 3-click rule.

 Have a consistency throughout your pages

◦ Colours

◦ Menu placement

◦ Layout

◦ Fonts

◦ Buttons

 Think about the layout, have white space, clean 

alignment and balance on your pages

http://usability.coi.gov.uk/themes/page-layout/assets/images/1a-1.jpg

https://www.microsoft.com/mspress/books/sampchap/6403/0-7356-18607-

04.gif
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Webpages and Websites

 A website is a collection of related webpages 

stored in a folder. The folder may or may not 

contain sub folders.

 The website folder should contain a sub 

folder called images which holds the image 

files (.jpg, .gif, etc) that will be displayed on 

the page.
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Decide on what webpages you will need.

 Each webpage is normally an html file, a file that 
has the extension .html or .htm
◦ .html .htm
 Very basic page, just has clickable links, images, sometimes 

forms

 The .html file is just a file with html codes that is displayed in a 
browser to make it look pretty for the client (Chrome, IE, 
Safari, Firefox)

 CS1033 just covers .html  & .htm pages

◦ Other extensions for webpages include:
 .php  extra stuff that is brought in also from the server, 

allows for use of data in a database on the server, more 
complex form manipulation

 Store each .html file in the folder (the Website)

 The home page for the website, the “starting page” 
should have the file name index.html

http://websitehelpers.com/design
http://usability.coi.gov.uk/themes/page-layout/assets/images/1a-1.jpg
https://www.microsoft.com/mspress/books/sampchap/6403/0-7356-18607-04.gif
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Webpages and Websites

 Question: On panther.uwo.ca, what is the 

main folder for your: 

http://publish.uwo.ca/~lreid2

 Question: Does that folder contain a file 

called index.html?

http://wts.uwo.ca/services/web/activate_my_per

sonal_web_space.html

CHECK IT OUT USING SECURE FTP 

(WINSCP, FUGU, FILEZILLA)
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Folder Structure for a Simple Site

 Decide on the pages you will need

 Create a top level folder. Use lowercase letters

 Give the home page the name index.html

◦ Must be all lowercase!

◦ Index.html is invalid

 Give the other pages appropriate lowercase 

names (no spaces in the file names) with the 

.html extension

 Create a subfolder called images (lowercase) 

and put all your images in that folder
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Example of a simple website

 Assume we are making a website about Polar 

Bears. The folder structure (folder is called 

H:\polarbears) might look like this:
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Links for the simple structure

 Assume the domain name for this site is: 

ArcticAnimals.org

 Thus the website would be:

◦ http://www.ArcticAnimals.org

 To get to the polar bear website, you could type:

◦ http://www.ArcticAnimals.org/polarbears OR

◦ http://www.ArcticAnimals.org/polarbears/index.html

 To get to the habitat page you would type:

◦ http://www.ArcticAnimals.org/polarbears/habitat.html 
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Something to try

 Go to your panther page and type each of the 
following:
◦ http://publish.uwo.ca/~lreid2

◦ http://publish.uwo.ca/~lreid2/index.html

◦ http://publish.uwo.ca/~lreid2/posterassign

Question: Why don’t we see a webpage when we type 
the last choice? 

 Now go to UWO Computer Science page and 
type each of the following: 
◦ http://www.csd.uwo.ca

◦ http://www.csd.uwo.ca/index.html
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More complicated site

 Sometimes websites have many submenus 

and have lots of webpages. 

 In this case we need a more complicated 

folder structure

◦ BUT it is NOT really that much more 

complicated, just one main folder with subfolders 

that contain “sub websites”

◦ Each sub website is a sub folder that contains it’s 

own index.html and images subfolder

http://publish.uwo.ca/~lreid2
http://wts.uwo.ca/services/web/activate_my_personal_web_space.html
http://publish.uwo.ca/~lreid2
http://publish.uwo.ca/~lreid2/index.html
http://publish.uwo.ca/~lreid2/posterassign
http://www.csd.uwo.ca/
http://www.csd.uwo.ca/index.html
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Example of a more 

complicated site:

 Westerns Computer 

Science Site might 

be set up like this 
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Web Server
 You will likely build your site on your own 

machine. When the website is completed you will 
need to move it to a Web Server

 Web Server  the computer that runs software 
which holds the webpages and serves up 
(delivers) webpage to the client. This computer 
must be connected to the Internet. The software 
delivering the webpages is also called a web 
server

 Question: What is the software we use to move 
the webpages we have built on to the web server?

 Question: What is the name of the web server 
machine at Western?
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Web Browser

 Once you have moved your website onto the web 
server you MUST test your website by opening it in a 
Web Browser

 Web Browser  software/program that displays 
formatted webpages to the client.

 Question:  What is the input we give a web browser?

 Question:  What is the output from the web browser 
program?

 Question:  Can you name 3 web browser programs?

 Question:  Does anyone know how you look at the 
html that was used to create the page currently 
displayed in the browser?
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HTML and Web Browsers
<html>

<title>Sample webpage</title>

<body>

Here is some <b>text</b> and a picture: <img src="sunset.gif">

and a link to <a href="http://www.uwo.ca">Western</a>

</body>

</html>

Input to 

Web Browser

Output from  

Web Browser

Stored on the 

webserver (the 

SERVER)

Viewed on the 

CLIENT
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What is HTML?

 History:

◦ In the late 1980s, Tim Berners Lee proposed a way of 
sharing research papers using the Internet and hypertext 
(immediate links to other documents)

◦ In 1990 Berners Lee set the specifications for the HTML 
language and wrote a browser to read HTML files and 
output linkable papers

◦ He proposed html tags
 Example of some tags  <html>, </html>, <b>, </b>,<ol>, </ol>

 Tag always start with “<“ and end with “>”

 Most tags come in pairs: opening tag and a closing tag, for example:

<title>This is the title of the webpage</title>

◦ Used to have to make html files (webpages) with simple 
text editors like Notepad
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History…

 Tim Berners Lee:

◦ Created the first web browser

◦ Created URL layout

◦ Came up with the World Wide Web and the 

concept of hyperlinks among pages

◦ Created HTML tags (they have changed a bit over 

time but he came up with the initial ones)

◦ Watch starting at 2 minutes
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Break

 Slideshow of Poster Assignments

Slide 40 of 54

History of HTML 

 Question:  Can you guess some of the tags 

you think we would need to create a useful 

and readable webpage?
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Types of HTML tags

 Section tags

◦ <html>, <body>, <head>, …

 Formatting tags

◦ <b>, <ul>, <i>,<p>,<h2>,</b>,</h2>, …

 Link tags

◦ <a href=“http://www.msn.com”>, </a>, …

 Placeholder tags (standalone or unpaired 

tags)

◦ <img src=“mydog.jpg”>, <hr>
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Let’s make a webpage the Old 

Fashioned Way!

 Open Notepad

 Save your file as myfirstpage.html

 Type in some tags

 Save the file again

 Close the file

 Double click on it, it should now open in IE

 In IE, from the menu select  View>Source

 Edit the tags some more and save the file

 Go back to IE and hit the refresh button
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It is way to hard to remember all the 

tags, so…
 WYSIWYG programs to the rescue! 

◦ Eg. Adobe Dreamweaver or BlueGriffon

 They creates the tags for us so that we 

don’t have to remember the syntax for 

each tag!

 Question: Can you still see the tags in 

BlueGriffon? If so, how?

https://www.washingtonpost.com/video/postlive/sir-tim-berners-lee-on-how-he-came-up-with-the-world-wide-web-and-why-your-kids-should-code/2019/03/05/13e0a62a-bcc7-423f-987d-788b8497696a_video.html
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BlueGriffon Tips
 Webpages will NOT format as precisely as something like a 

MS Word document to be printed because everyone’s 
resolution is different and screen size is different. 

 Design a template/layout and then save it and make copies 
for each page in your site and add the content to the 
copies

 Don’t forget to make an images folder! Put your images in 
the folder BEFORE you start adding them to your page.  
ALWAYS ADD THE IMAGE TO THE IMAGES FOLDER 
BEFORE YOU PUT IT IN YOUR PAGE!

 Try previewing your page in more than one browser

 It is easier to create the top level folder and subfolders 
first and then point BlueGriffon to that folder

 Always use lower case names with no spaces for all folder 
and all file names
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Page Title

 Shows up now at the top of the tab

 Page title is very important, when you print a 

webpage, the title appears at the top of printed 

paper

 Search engines look at page title

 Title is displayed in the list returned by Google

 Always set the page title on all your pages

 Start with the site name, then hyphen and the 

page description

◦ Examples:   
The Department of Computer Science – Undergraduate Information

Laura K. Reid Online Resume –Work Experience
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Google Does It Right!
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In BlueGriffon

 In menu bar:

Format>Page Properties

 Type in Site Name HYPHEN Page Name, e.g.

Laura’s Stained Glass – Home
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Formatting Text

 Headers  H1, H2, H3, H4, H5, H6

◦ H1 is the largest

◦ All are bolded

 Should use pixels rather than points for text 

size. Use ems or % when the audience might 

need to enlarge the text 
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Changing Background and Link Colours

 If you decide to use a background image, 

make sure it is not too busy and the image 

file size is small.

◦ https://affinity.pt/en/

 Don’t forget about your links colours either! 

Try to pick colours that work with your site 

palette: http://duomgmt.com/

 Remember to use GOOGLE!

https://affinity.pt/en/
http://duomgmt.com/
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Graphics

 Use common universal formats such as jpg, 

gif and png files that will work in any browser

 Resize and compress the image as much as 

possible in Photoshop (or other graphics 

package)  BEFORE putting it in with 

BlueGriffon.

 Any resizing you do within BlueGriffon will 

not affect the download speed
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Graphics continued

 ALWAYS set the alternative text:

◦ Meet Barriers Free Access Requirements

◦ Shows when page is loading

◦ Shows up when using a text browser

 Set the Title attribute

◦ Shows when mouse hovers over

TYPES OF LINKS

5 Basic Ones
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Links – Type 1

 TYPE 1: Links to other pages within 

your site:

◦ For Example:

 Link from index.html to contactinfo.html

 Link from contactinfo.html back to index.html

http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/
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Links – Type 2

 TYPE 2: Link to a different website

◦ For example

 Link from index.html to http://www.utoronto.ca

 Should open in new window or tab

 Make sure you have http:// in front!
http://cs1033.gaul.csd.uwo.ca

/~lreid2/examplesforta/assign

3/student1/references.html
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Links – Type 3

 TYPE 3: Link to an email address

◦ For example:

 Link to homerjsimpson@yahoo.com 

 Clicking on the link brings up default emailer like 

Outlook

http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/s

tudent1/contactinfo.html

http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/
http://www.utoronto.ca/
http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/references.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/contactinfo.html
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Links – Type 4

 TYPE 4a: Link on a image

◦ On the whole image:

 Link to http://www.canada.gc.ca 

 http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/ass

ign3/student1/contactinfo.html (click on banner)

 Want it to open in a new tab/window if it goes OFF 

your site,you must do this IN the code (source tab)
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Links – Type 5
 TYPE 5: Link to particular spot within a 

page

◦ The spot is called the bookmark or the named anchor

◦ Find the spot you want to jump to, put your cursor 

there and then select  Insert>Named Anchor

◦ Give the spot a name you make up, for example: 

middleofpage

◦ Go to where you want the link and add a link with # 

in front of it and the name of the anchor:

http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/staff.html
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Links – Type 5

 Named anchors can link to any spot within 

the current page OR you can link to the 

middle of another page, for example:

◦ http://en.wikipedia.org/wiki/Jpg#Sample_photogra

phs

 Use named anchors to make Back to Top 

buttons or jump from a list to another area 

of the page

Named 

Anchors 

used on 

this page
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Next week

 Searching

 FINAL REVIEW QUESTION: If you are 

creating a webpage for the Contact Info 

about your Scuba Diving Business, which 

would be the best title for the page:
a. Contact Info

b. Untitled

c. Laura’s Scubalious Diving Co

d. Laura’s Scubalious Diving Co – Contact Us

http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/contactinfo.html
http://cs1033.gaul.csd.uwo.ca/~lreid2/examplesforta/assign3/student1/staff.html
http://en.wikipedia.org/wiki/Jpg#Sample_photographs

